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GeneMarker v2.9.0 Manual

1 Guiding Principles and Scope

1.1  This method contains the steps for the analysis of PowerPlex Fusion and Yfiler STR runs from the
3130 using GeneMarker HID v2.9.0.

1.2 For more information on the use of GeneMarker HID v2.9.0 see GenerahOverview Section 20.

1.3 For first time GeneMarker use, for a new installation, or for iléw computer hardware see QC355-
GeneMarker setup.

1.4  This manual cannot cover all situations that could arise during the'analysis of an STR run. If an
analyst encounters something that isn’t covered byathis manual, they ‘should seek their supervisor
for further guidance.

2 Load Data

2.1 To start your project, go to File — Opendata — Add

2.1.1  Navigate to the network folder containing the data files (i.e. the .fsa files) to be
analyzed.

2.1.2  Select files to add (includeronly one ladder per project)
2.1.3  Hold Ctrl key to seleéet multiple files

2.1.4 ( Ifanalyzing alhfiles hold Ctrl and A keys

2.1.5  Select Open

2.1.6  Ensure correct files are added to list

2.1.7  Ensure Auto-Elevate is not selected.

2.1.8  Select OK

2.2 Ensure that prefixes LD, PC and NC are labeling the allelic ladder, positive control and
negative control, respectively, in the Sample File Tree.

2.2.1  Ifthey are not, right click on the sample name in the Sample File Tree — Set Sample
Type — Select appropriate sample type
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2.2.2  Click Run Project located in the top toolbar.

3 Run Wizard

3.1  In Template Selection window, select the appropriate existing template; Fusion (Evidence),

Fusion Exemplars, or Yfiler® (Evidence or Exemplars). If “Last T 2is displayed in
Template Name field, ensure that the appropriate Panel is listeddor your analysis.

3.1.1  Note: Do NOT click Save on any of the following windows. This,will overwrite the
template for all analysts.

3.2 Fusion (Evidence)

Template Name: |Fusi|:|n
Panel: |Fusion_OCME_no filter = | EI == |
Size Standard:  [ILS500 - ‘_I_I_m |

Standard Color: |ORANGE 4 |

3.2.1 Click Next

3.2.2  Inthe Data Processiswindow, ensure the following settings are used:
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Run Wizard E1

Data Process - HID Analysis
Set data process options

— Raw Data Analyziz

Start: ID

[+ Superior

WV Auto Range [frame]

— Allele Call
[~ Aute Range (bps]

[+ Smoath
Baszeline Subtraction:
[~ Classic

[~ Pull-up Comection

¥ Saturation Detection [~ Saturation Repair

=

End: [10000 ]
[~ Enhanced Smooth

*

Start: |55

[~ Enhanced

¥ Spike Removal

Size Call

¢ Local Southem

i~ Cubic Spline

End: |51n

& save | Delete
323 Click Next
3.24  Inthe Additional
Run Wizard E
LI v Auto Select Best Ladder
s IPP—F““” LI v Auto Panel Adjustment
Check |1 juli| < Pass
T Misture Evaluation
Walid Misture Peak Percentage: ID %
Iir Miture tarker Humber: |3
[ save | Delete << Back ok Cancel |
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3.3 Fusion Exemplars
3.3.1 Click Next
3.3.2  Inthe Data Process window, ensure the following settings are used:
Run Wizard @1
Data Process - HID Analysis

Set data process options

Faw Data Analyziz Allele Call & D " 4

[v Auto Range [frame) [~ Auta Range [bps)

n 3 10000 3 St [58  a)y ENd 510 3]

[v Smooth [~ Enhanced Smoath ¥ ScafeFilter

Baseline Subtraction: Peak Detection Threshald: ll

[v Superior [” Classic [ Erhanced Mir Itensity: |50 41 MaxIntensity: |32760 4

[ Pullup Corection v Spike Removal | Fercentage > l1D | Global Max

[v Saturation Detection [~ Saturation Fepair NotehlUse Panel Editar ta set Min Intensity

: and % Glakbal Max for peaks within Markers

Size Call |
o Local Southem i Cubic'Spline
& save ‘ | << Back ‘ Cancel

3.3.3  Click Next
3.3.4  Inthe AdditionaliSettings window, ensure the following settings are used:

Run izacd_ N
Additional Settings -"HID Analysis

Set additionaloptions related to the different analyzis type

[none

=
=

Aer:

Positive Control Template: |PP_FusiDn

Allele Evaluatior
Peak Score:

Reject < |0.00 Check |1.00

[~ Misture Evaluation

< Pasz

—
—

nSave ‘ | << Back |

(B8

Jv Auto Select Best Ladder

[v Auto Panel Adjustment

Cancel
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Sel data process options

FRaw Data Analysiz
[ Auto Range [frame]

Data Process - HID Analysis

Start 2300 4]
V¥ Smoath
B aselingdSubtraction:
I~ ASuperiar | Classic

v Pullup Cafrection

-

Size Call
e Local Southerm

& save |

End |3000 @

.- Enhanced Smoath

[~ Enhanced

% Spike Removal

v SaturatanBetection [ Saturation Repair

" Cubic Spline
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3.4 Yfiler® (Evidence or Exemplars)
Template Mame: |TFiIer
Panel |vfiler_ocME = g
Size Standard:  |LIZ_Yfiler - M
Standard Color: ||:IFI.-“-‘-.NI3E j
3.4.1 Click Next
3.4.2  Inthe Data Process window, ensure the following settings.are used:
Run Wizard : \ ‘ \E\

Allele Call
[ Auto Range [bps)

=

Start |75 End 410 3]

[v Score Filker
Peak Detection Threshald: j

Min Intensity: |75 = MaxIntensity: |20000 %
Percentage > |8 5| Global Max

Mote: Use Panel Editor to set Min Intensity

and % Global Max for peaks within Markers

<¢ Back

LCancel

343  Click Next

344
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Run Wizard @

Additional Settings - HID Analysis

Set additional options related ta the different analyzis bupe

NOME J v Auto Select Best Ladder

Fositive Control Template: |Yﬁ|er MPC j v Auto Panel Adjustment
Allele Evaluation

Peak Score:

Feject ¢ |0.00 Check |1.00 < Pass

[~ Mixture Evaluation

3.5 IfNONE is listed under Positive control tefaplate, select the Positive Control Template using the
dropdown:

o For PowerPlexiFusion® (all templates) - PP_Fusion
o For tiler® - YfilerMPC

3.6  Note: Do NOT click Save within the Data Process Window. This will overwrite the template for
all analysts.

3.7  Click OK — Once datathasifinished processing Click OK
3.8 On the teppleft corner ofithe screen, Click File — Click Save Project — Navigate to desired
folder and save preject using the naming system based on the instrument, date, injection

number(s); kitdnd analysis set (i.e. Newton090615 8-11U A)

3.8.1  Youmust save over the existing project every time you save.

4 Checking the Size Standard

il

4.1  Located on the top toolbar in the main analysis window, Click Size Calibration

4.2 Inthe Calibration Charts window, Click Chart Synchronize ~—

4.3  Click Sample Name header to sort samples in order. In the Sample List, either Click on a
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Sample or Navigate using the Up/Down Arrows, check the size standard for each sample and
control as per the amplification kit.

4.3.1 PowerPlex Fusion®

6065 80 100 120 140 160 180 200 225 250 275 300 325 350 375 400 425 450 475 500

800 |
800 |
400 | ¥¥ ¥ ¥ ¥ v ¥ v ¥ T ¥ ¥ v v T T
200 |
|

T T T T T T T T g T T T
2,500 3,000 3,500 4,000 4,500 5,000 5,500 €,000 €.500 7.000 7,500 8,000

432 Yfiler ®

75 100 139 150 160 200 300 340 350 400
8,000
¥y v 7 A v vy v ¥
v
4,000 v “
2,000
0 N N

2400 2600 2300 3.000 3200 3.400 3600 3300 4000 4200 4400 4600, 4300 V5000 5200 5400 5600 5300 6000 6200 6400 6600 6300 7.000

4.3.3  Ifthe peak is recognized by the seftware, a green inverted triangle appears at the top of
the peak. '

434  If a samplécontains ajsize standard peak without a green triangle present the size
standard for that sample fails. Refer to STR Results Interpretation-PowerPlex Fusion &
STRmIXTM niantai:

4.4 Close Calibzration Charts,zwindow.

4.4.1  Ifany sample or control is automatically marked as disabled by the software, review the
size standard in the Calibration Charts window to ensure this was due to failing or poor
size standard. If it is confirmed that the sample has a failing or poor size standard, a
rerun code must be applied to that sample. Right click on the sample in Sample File
Tree within Main Analysis Window = Click Edit Comments > Enter rerun code in
Comments field 2 Click OK

442  Inthe Main Analysis window, Click on the Down Arrow next to the Show Color
icon located in the top toolbar. — Click Hide All

4.43  Inthe Sample File Tree, Right Click on Allele Call —Click Select Max
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4.4.4  Inthe Main Analysis window, Click on the Down Arrow next to the Show Color
icon located in the top toolbar. — Click ORANGE

4.4.5  Note: The size standard can also be viewed in the Browse by All Color Window
4.5  Adjust axis to view size standard depending on amplification kit

Y,

4.5.1  On the top toolbar, Click Set Axis icon
4.5.2  Click Fixed ‘X > — enter X axis range

° PowerPlex Fusion® = 55-510
° Yfiler® = 75-410

4.5.3  Click Set Axis again — Select Auto Fit'Y.
4.6  Review size fragments by ensuring that allaequired peaks are labeled within +/- 0.5bp of the

fragment size. See the Fusion Ladder, PE and'SS appendix or for Yfiler, the References - Allelic
Ladders, Controls, and Size Standards documents.

4.6.1  If apeak is not labeledsemnot within +/-0.5bp, then the size standard fails. Refer to STR
Results Interpretation-PowerPlex Eusion & STRmixTM manual.

4.7  Ifany sample with failing or poor size standard has peaks called, the peak labels of those peaks
will need to be deleted.

4.7.1  Open'the Browseiby.All Color analysis window > navigate to the relevant sample(s) =
highlightalipeaks in one dye by holding down Ctrl, left click and dragging around any
peaks presentin that dye > click Delete to remove the peak labels—> repeat for each dye

4.8  For any sampledwith failing or poor size standard, right click on sample in Sample File Tree within
Main Analysis Window - Click Edit Comments—> Enter rerun code in Comments field—=> Click
OK

5 Checking the Allelic Ladder

5.1  There are two areas in the Main Analysis window that indicate if the allelic ladder used for
analysis has passed.

5.1.1 In the Sample File Tree, a red question mark next to the allelic ladder would indicate a
potentially failed ladder.
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5.2

53

54

5.1.2  Inthe Project Summary, a ladder error would indicate a potential failed ladder.

Right click in the Sample File Tree = Click Select Max. Open the Browse by All Color Window

==

icon = Visually confirm all expected alleles in the allelic ladder are present. Refer to the
Fusion Ladder, PE and SS appendix or for Yfiler, the References - Allelic Ladders, Controls, and
Size Standards documents.

If the ladder used for analysis failed, try another ladder present on the same analysis set if one is
available. Click File from the menu bar > Click Open Data - Highlight the failed ladder from
the Data File List 2 Click Remove = Click Add... > Navigatedo the'.fsa files 2 Select a
different ladder for analysis = Click Open -> Click OK. Return to Load Data,Section 2.2 and
proceed.

If there are no other passing allelic ladders in the analysis'set refento Refer to STR Results
Interpretation-PowerPlex Fusion & STRmixTM manual.

6 Amplification positive control (Fusion/YFiler)

6.1

6.2

6.3

6.4

For any STR plate, there must be at least one@amplification positive control present.

The amplification positive contrél'fnay be sun at a different dilution than the corresponding
samples and the amplificatigh’set can pass.

A positive control may be edited for amplification or electrophoresis artifacts including (but not
limited to) pull-up,stutterand elevated baseline.

Visually confirmall thefexpeeted alleles in the positive control according to the amplification kit
used. Refer to the Fusion Ladder, PE and SS appendix or for Yfiler, the References - Allelic
Laddersg@ontrols, and'Size Standards documents..

6.4.1  Apositive eontrol that does not generate a complete genotype or gives an incorrect
genotype will be indicated as failing. Refer to STR Results Interpretation-PowerPlex
Fusion & STRmixTM manual for re-testing strategies

7 Negative Controls (Fusion/YFiler)

7.1

Evaluate the extraction and/or amplification negative control for expected results. If peaks
attributed to DNA are detected refer to STR Results Interpretation-PowerPlex Fusion &
STRmixTM manual.
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7.2

7.3

Some artifacts can be edited in a negative control if they are by-products of the STR/amplification
process. These include artifacts such as dye blobs, spikes, and primer front. Only re-test if
artifacts are so abundant that amplified DNA might be masked.

If a negative control with no peaks present contains misshapen size standard peaks that are
correctly called, the control passes.

8 Analyzing Samples

8.1

8.2

Analysis of the data can be performed in the Main Analysis window and/or the Browse by All
Color EZ window.

Adjust axis to view samples depending on amplification kit
8.2.1  On the top toolbar, Click Set Axis icon &

8.2.2  Click Fixed ‘X * — enter X axis range

e PowerPlex Fusion® = 60-510
e Yfiler® = 90-340

8.2.3  Click Set Axis again’— Select Auto Fit Y

9 Editing a peak

9.1

9.2

9.3

If a labeled peaK is determined to be an artifact, click on the Peak to Highlight — Right Click—
Click Edit Comments<> Enter code ‘a’ for artifact (refer to the editing codes document) — Click
OK.

9.1.1  'To selectmultiple peaks for editing, Hold the Ctrl key + left mouse click — Drag the
mouse to highlight all consecutive peaks

Once the Edit s selected, highlight the peak and press Delete key to remove the label from the
peak.

9.2.1  Note: Ifa label has been removed from a peak and needs to be restored, Click on Peak
to Highlight — Right Click —Undelete. If an edit needs to be removed from a peak >
right click on peak = click edit comments = remove text from Comments: box so the
text field is blank = Click OK (the E will still be visible but the edit comment will be
removed)

To check peak history = Right click on peak = Click view history
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9.3.1  Any changes made to the peak will be listed in order from most recent down. Click on
any line to view specific change details in the Current/Old Values: window. Scroll all
the way to the right to view edit code applied to peak in Allele Comments column.

9.4  +/- one repeat stutter should not be manually edited from evidence in Fusion. Stutter can be edited
from Fusion positive control samples and exemplar samples.

Note: Peaks will only be considered stutter by the software if they are within'the bin of the stutter
peak. If a peak is outside of the stutter bin of the parent peak the software will not automatically
filter this out as stutter, even if is under the stutter filter percentage forthat location.

10 Over- Saturation
10.1  Check for saturation detection

10.1.1 In the Main Analysis Window electropherogtam a pink line will indicate the possible
saturation of peak. This indication will also be noted in the Peak Table as <SAT> for
that allele in the Allele Comment field.

10.1.2  If an evidence sample has@xcessively saturated peaks (>10,000 RFU or split peaks) this
sample must be rerun at a dilution. All peak labels must be removed. Enter the
appropriate re-run ¢ode and dilution factor.

10.1.3  If an evidence sample has labeled peaks above 7,000 RFU, with minimal artifacts,
editing maysbe performed. If there are many instances of pull-up, pull-down, and/or
elevateddaseline, the sample may be rerun at a dilution. All peak labels must be
removed. Enten'the appropriate re-run code and dilution factor.

10.1.4 _Exemplars‘ot positive controls with saturated peaks may be interpreted if artifacts are
casily. recognizable and can be edited. With the exception of Fusion Direct samples,
exemplar§ymay be rerun at a dilution if needed.

11 Scheduling Re-Runs

11.1 Ifasample Failed (over saturation, bad size standard, no data, instrument issue, etc.) = Right
click on sample in Sample Tree within Main Analysis Window = Click Edit Comments 2>
Type Re-Run Code in the comment box = Click OK

11.1.1  Re-run codes cover the majority of, but not all, situations. If one does not exist which
specifically describes the issue, please enter a reason in LIMS as to why the sample
failed under the sample status column — ex. possible injection issue.

11.2  All peak labels must be removed from failed samples.
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11.2.1  Open the Browse by All Color analysis window —> navigate to the relevant sample(s) -
highlight all peaks in one dye by holding down Ctrl, left click and dragging around any
peaks present in that dye = click Delete to remove the peak labels—> repeat for each

dye.

11.3  If sample did not fail but re-run is desired = Right click on sample in Sample Tree within Main
Analysis Window - Click Edit Comments = Type Re-Run Code in the comment box = Click

OK

12 Exporting for LIMS (all systems and sample types)

12.1 Once the entire run has been reviewed, all edits have been made andlabels have been removed
from all edited peaks, on the top left corner of the screen,€lickiFile — Click Save Project

12.2  You must save over the existing project every time,you save.

12.3  In the Main Analysis Window = Click the downarrow nextito'the Show All Color icon = Click
Show All to turn on all colors before exporting.

12.4  In the report display section of the main analysis'sereen, click on the down arrow next to the Save

Report icon = - . Ensure ther*Save LIMS report” is selected.

12.5 In the LIMS report settings window that'pops up, ensure the settings are as follows:

12.5.1 The Size Range will'beythessame as the X- axis range for analysis

e 90-340 fonfYfiler
e 60-5100or Fusion/Fusion Exemplars
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LIMS Report Settings @
Dyes Optiong

¥ BLUE w RED [¥ Size Fangelbps)

GtrEs . From |50 to {5101

W YELLOMW,

I~ Abide By Panel

[~ Grouped By Markers
[ Show File Mame

Columns... |
[~ Show Sample Mame
v Show Deleted Peaks r ’T
|~ Hide Extra Sample Names [~ Shaow Only Uncertain Alleles
[~ Ewclude Report Header v Show Rejected Low Score Alleles

Ok Cahcel |

12.5.2  In Options, click on “Columns.:.”; use'the Add/Remove buttons to ensure the Selected
Columns are present and listed in the order that follows:

Selected Columnz

Plate 1D

b arker

Dye

Size

allele

Allele Comments
Sample Comméntz

Note: Thisyis crucial to proper LIMS importation.
12.5.3 Click OK; Click OK again in the Allele Report Settings window.

12.6  Save the file as type “Excel File (*.xlsx;*.x1s)”” under the appropriate run name (delete suffix
“ AlleleReport™).

12.7 Navigate to the data entry screen for the corresponding test batch in LIMS. Click Import
Instrument Data and import the excel file for the project.

12.8  Fill out the data entry screen keeping in mind the following definitions:

12.8.1 Loaded — the data from GeneMarker has been imported
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12.8.2 Not loaded — the data from GeneMarker has not been imported, or the labels have been
removed from all peaks

12.8.3 Pass — the control has passed
12.8.4 Fail — the control has not passed
12.8.5 No Data — the control has not been analyzed

12.8.6  Not Used — the control was not used in analysis of the STR'tun, typically reserved for
additional allelic ladders

12.9 If a control needs to be rerun, a comment (reason as to why<the sample failed)and resolution must
be entered into the LIMS data entry screen.

13 Printing Initial Analysis Electropherograms (all system and sample types)

Note: If exporting a PDF of an electropherogramfrom arun that was analyzed in GeneMarker v
2.8.2, please refer to section 19.

13.1 In the Sample File Tree = right click =>ysélect Max.

13.1.1 Double-click to DESELECT the failed samples that are scheduled for rerun due to “no
or poor size standard”. The .pdf of electropherogram is not necessary since the sample
status is indieated onythe rerun table.

13.1.2  Includé all samples that failed for reasons other than “no or poor size standard.” The
.pdfs of'the electropherograms with all peak labels removed must be included within the
casefile.

13.2  Click View~> Prefesences = Others tab
13.2.1  Ensure box for “Enable Sample Grouping” is checked = Click OK

13.3 In Main Analysis Window click Project > Apply Sample Grouping (if grayed out return to step
13.1)

13.3.1 Click Group By Order on the bottom left
13.3.2 Change Group Size to 1

13.3.3  Click Match on the bottom right = Click OK
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134

the same as the X- axis range for analysis:

e 60-510 for Fusion
e 90-340 for Yfiler

13.5 Click Set Axis again — Select Auto Fit Y e

13.6 In Main Analysis window = Click Print Icon

13.6.1 Select OCME Print Template on left and ensure the s

13.6.1.1

Standard Tab:

Print Report

" Use Last Templ

b Standard
¢ Selact an Existing Template or Create One anaar I"ﬁ“:l\"f'me‘:I Page

Template: Name: IDCME Print Template ’7 Print Type
E)OCME Print Template

¢ Mommal

Sample

Al Samples ¥ BLUE

W GREEN
W YELLOW

D}'ES*

W FED
™ ORANGE

[~ MixDyes
¥ Hide Bins

art on Separate Page

[” Forenzics Table

& save | X Delete | & 0k |

LCancel

Advanced Tab:

In the main analysis window = Click Set Axis = Click Fixed X axis. The Size Range will be
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Print Report (==

. I Ad d
* Select an Existing Template or Create One Standard ance | Page I

Template Mame: IDCME Frint Template Header:
[~ Print Project Comments [~ Each Pace [ WwWord Wiap
EJOCME Print Template

v Print Report Headsr v Each Page

I~ Label Dyes & Peak Numbers W File Mame [~ Sampls Mame

Marker: Allele:
W Print Markers W Print Alleles
[~ Ahide by Pansl I~ Frint Edited Peak 0

[ Auto Scals Markers
Other:
I~ Grouped by Dye

v tark Deleted/E dited

v Mew Page for Each Sample

v Implement % Axis Settings

€ Use Last Template ¥ Prinit 5 amples ‘wWith Grouping

13.6.1.3 Page Tab

Print Report (2]
¢ Select an Existing Template or Create One
Template Name: |OCHME Frint Template
EROCME Print Templat
Faper
Size Type: ILetter LI

“width (mm]: |215.9 Height [rnr): |2?9.4

— Margin [mm) Orientation
Left: [12.0 Right: [12.0 & Portrait
Top: |13.D Battom: |'|3-D ¢ Landscape

" Use Las plate

n Save | x Delete | % Ok | Lancel |

13.6.2  Click Preview = Click Export to File icon ® Assure settings match below:
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Export Report to Files @
Export Format:  |POF file j

File M aming bethod
{* Mamed by zample name
[ Start by Page Mumber
" Mamed by file name
-

" Mamed by page number

W Save Group Samples as One File

13.6.3 Click on the “...” icon to choose the appropriate export'directory for the PDF files

13.6.4 Click OK = Export Report to PDFs Eventsiwindow, will appear. Once completed click
OK

13.7 If analyzing Fusion Evidence: Wait to import PDFs mto LIMS until after the completion of
STRmix analysis, section 15.

13.8 If analyzing Exemplars or Yfiler'Evidenee: Import all PDFs into LIMS.

14 Fusion Exemplars Only = Exporting EXEMPLAR table for STRmixTM
input (for evidence table instructions see Section 17)

14.1 In Main Analysis Wimdow Click the ﬂ " icon - Select Show All In the report display section

L
of the main analysis,screen, click on the report settings icon . Make sure settings match
below:
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14.2

14.3

14.4

14.5

14.6

14.7 Navigate to folder containing your project data and save file there.

* Forensics
" Bin Table
" Peak Table
" Allele Count

v Show File Name
[~ Show Sample Name

Orientation

[T Exclude Sample Index
[~ Exclude Report Header

" Horizontal (¢ VYertical

Ok

[v Show allele Name
v Show Size (0.1bps)
v Show Height
[~ Show Area
[~ Show Score

GeneMarker Manual
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| Allele Report Settings =5 |
~Report Style Options
" Allele List v Extend Diploid Homozygous

Click OK - In thedeport displayysection of the main analysis screen, click on the down arrow

. il .
next to the Save Reportdcone==-_ . Ensure the “Save Report” is selected.

Navigatede,appropriatexfolder and save file as an excel file (*.xlsx;*.xls)’named as “Run

name SM?

For proper STRmix™ import the GeneMarker® to STRmix™ macro needs to be run.

14.4.1 Open the exported project excel file from Step 14.3 above.

14.42  Open GeneMarker® to STRmix™ macro.

14.4.3 Follow the instructions on the “instructions” tab.

After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.

Change the file type to “.txt” (text, tab delimited)

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax

software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER



http://qualtrax.csc.nycnet/Default.aspx?ID=6283

FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

GeneMarker Manual

Status:Published Document ID: 6311
DATE EFFECTIVE APPROVED BY PAGE
09/10/2019 Nuclear DNA Technical Leader 19 OF 38

15 Fusion Evidence Only - STRmix™ Analysis (stutter filters off)

15.1 Begin by importing the data from the initial analysis into LIMS to generate the edit sheet. Have
the edit sheet open in LIMS as you perform the second analysis with stutter filters off for
STRmix™ to refer to and ensure the same edits are being made the second time.

15.1.1  If Project is still open = Click Run Project -~ located in the topsteolbar.
15.1.2 If project is not open = Click File - Open Project > Navigate to run 3 select project
-> click open = Click Run Project _”_ located in the top toolbar.
15.2 In Template Selection window, select the appropriate existingtemplate.
Run Wizard EI
Template Selection
Set the template of the project
& Select an existing template or create one
aFUSiDI'I Template Name: |Fusion_STRmix
grs Panct [ForopdBone @ian o WL | i3
A YFiler - Size 5tandard M—ﬁw
Standard Calor: !DF\ANGE -
™ Use last template
= Save | ¢ Deleté | Hext > | LCancel

15.3 Click Next
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15.4

15.5

15.6

In the Data Process window, ensure the following settings are used:

Data Process - HID Analysis
Set data process options

Faw Data Analysiz Allele Call
[ Auta Range (frame] [~ Auto Range (bpz)
P = 10000 2] st [55 3]  End [5T0 3
v Smooth [~ Enhanced Smooth [l S core Filter
Bazeline Subtraction: Peak Detection Threshald: j
[v Supenor [~ Classic [ Enhanced in Intensity: m M ax Intensity: ]ﬁﬁz’
[ Pullup Correction v Spike Removal Percentage » m Global Max

[ Saturation Detection [ Saturation Repair Nate: Use Panel Editor ta set Mih Intensify

) and % Global Max for peaks within Markers
Size Call

{* Local Southern " Cubic Spline

& 5ave | << Back

Run Wizard @

Click Next

In the Additional Settings window, ensure the’following settings are used:

T O 4
Additional Settings 1 HID Analysis
Set additiondl eptions related ko the different analysis type
SIES: HoNE = W fwta Select Best Ladder
Positive Contral Témplate: |PP_Fusi0n ﬂ W Auto Panel Adiustment
Allele Evaluation——
Peak SGore:
Feject < |0.00 Check [1.00 < Pazz
[~ Misture’ Evaluation
a
3
& 5ave | | << Back Lancel

=i

15.6.1 Note: Do NOT click Save within the Data Process Window. This will overwrite the

template for all analysts.
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15.7 Click OK = A window will pop up:

Use Old Calibration (=25

& Size Calibration

The internal lane sizes hawe been calibrated in the samples.
“ou may check Call Size Again to recall the sizes.

What to do:

Apply bo Al | Apply to Current

15.7.1 Check “Call size again” and Click Applyite,All - Allow data to process = Click OK

15.8  On the top left corner of the screen, Click File 2*Click Save Project = Save Project with suffix
_SM

15.9 Perform a second analysis of this run

15.9.1 Do not recheck or gdit Ladder, Size Standard or Controls. Passing controls and size
standard are detenmined by thesinitial analysis. Leave all controls and failed samples
ENABLED

15.9.2 Remove'the labels from the same peaks that were edited in the initial analysis. It is not
necessary to endtemedit codes again.

15.9.2.1 If an artifact (excluding stutter) was previously filtered out in the original
analysis (ex. a pull-up that was adjacent to a stutter bin) but is present in
the STRmix analysis, the label must be removed from this analysis set.
This edit must be recorded directly into the LIMS data entry screen.

15.9.3 If a'sample had a rerun code during the initial analysis it is NOT necessary to enter the
rerun code again.

15.10 Once the entire run has been reviewed, and labels have been removed from all artifact peaks,
Click File — Click Save Project
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16 Fusion Evidence Only - Printing Electropherograms after STRmix™
Analysis (evidence samples only)

Note: If printing or exporting a PDF of an electropherogram from a run that was analyzed in
GeneMarker v 2.8.2, please refer to section 19

16.1 In Sample File Tree = right click = Select Max

16.2  Double click on sample to DESELECT:

All Controls (Ladder, PC, NC, Eneg, Mneg)
e Any failed sample

16.3  Click View—> Preferences = Others tab
16.4 Ensure the box for “Enable Sample Grouping” is‘cheeked = Click OK

16.5 In Main Analysis Window click Project 2¢Apply Sample Grouping (if grayed out return to step
16.1)

16.6  Click Group By Order on the bottom left
16.7 Change Group Size to 1
16.8 Click Match on the bottom right = Click OK

16.9 In the main analysis window => Click Set Axis = Click Fixed X axis The Size Range will be the
same as the X- axis rangé foranalysis:

&y 60-510 forFusion
16.10 Click Set Axisdgain=> Select Auto Fit Y
16.11 In Main Analysis window = Click Print Icon
16.12 Select OCME Print Template on left
16.13 Ensure the settings match below:

16.13.1 Standard Tab:
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. Standard
i+ Select an Existing Template or Create One andar IAdvancedI Page I

Print Report E

Template Mame: IDCME Prirt Template

Frint Tupe
’7(3' Mormal

= Chart Overlay ‘

EJOCME Print Template

Sample
Al Samples

{* Selected Samples

Dye
v BLUE ¥ RED

[V GREEN [~ ORAMGE
WV YELLOW

Content
v Electropherngram
PeakT able
% Faollow Trace Chart
€ Start after &1l Charts Finished
€ Start on Separate Page

[” Forensics Table

7 Usze Last Template

I~ MizDyes
v Hide Bins

16.13.2 Advanced Tab:

Print Report

* Select an Existing Template or Create One

Template Mame:

OCKE Print Template

EJOCME Print Templa

[ Print Markers

[~ Abide by Panel

¥ Auto Scale Markers
Other:

I~ Grouped by Dpe

¥ Mew Page for Each Sample

¥ Implement ' Axis Settings

7 i ] .
0 Use La@hmplate v Print 5 amples WwWith Grouping

ents: [~ EachFPage

I~ word Wrap

¥ Each Page

ves & Peak Mumbers W File Name [~ Sample MName
Allele:

[ Print Alleles
I~ Frirt Edited Peak Orily
¥ tark Deleted/E dited Peaks

Label Peak Ratio
% Label Peak Height Fatic
" Label Peak Area R atio

Chart Height (mmi: [38 j

TR

So |

LCancel |

16.13.3 Page Tab
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Print Report (==
* Select an Existing Template or Create One 'Slandard | Advanced Page
Template Mame: Im
— Paper
Size Type: I Letter LI
width [mm):  |215.9 Height [rom):  |279.4
— Margin [mm) Orientation
Left: [12.0 Right: [12.0 & Portrait
Top 130 Battom: [13.0
 lse Last Template

& save | X Delete | & Ok

16.14 Click Preview = Click Export to File icon =

SSu; i
e T \

Expodt Format | POF file

atch below:

File Naming Method

16.15 Click on the¥%..” icon to choose the appropriate export directory for the PDF files

16.16 Click OK > Export Report to PDFs Events window will appear. Once completed click OK

16.17 Import all PDFs (initial Fusion analysis and STRmix analysis) at the same time into LIMS.

17 Fusion Evidence Only - Exporting EVIDENCE table for STRmix™ input
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17.1

17.2

17.3

17.4

17.5

In the report display section of the main analysis screen, click on the report settings icon .
Make sure settings match below:

Allele Report Settings \
Report Style Options
" Allele List [v Extend Diploid Homozygous
* Forensics
" Bin Table v Show Allele Name
" Peak Table [v Show Size (0.1bps)
" Allele Count [V Show Height
[~ Show Area
v Show File Name [~ Show Score

Show Sample N
[~ Show Sample Name [~ Show [ When No Allele Cal

Orientation I~ Show Only Uncertain Allelé8
" Horizontal & Vertical
[v Show Rejected Low Seare Alleles
[~ Exclude Sample Index [~ Hide Extra Sample Names

[~ Exclude Report Header [~ Show Selected Samples

(o ] e

Click OK

In the report display section of the main‘analysis screen, click on the arrow of the Save Report

icon e - . Click “Save/Report”

Navigate to appropriate folder and save file as “Excel File (*.xIsx;*.xls)” named as “Run
name SM?

For proper STRmix™/import the GeneMarker® to STRmix™ macro needs to be run.
17.5.1 Open the exported project excel file from Step 17.4 above.

17.5.2 Open GeneMarker® to STRmixTM macro.

17.5.3 Follow the instructions on the “instructions” tab.
17.5.4  After macro has run click “save as” within the GeneMarker® to STRmix™ macro file.
17.5.5 Change the file type to “.txt” (Text, tab delimited)

17.5.6  Navigate to folder containing your project data and save file there.
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18 Reporting Analyst/Case Tech Reviewer Sample Review
18.1  Verify all STR runs associated with case file samples checking for:
18.1.1 Passing Allelic Ladder was used to analyze run
18.1.2  Passing controls were present
18.1.3 Passing Size Standard for relevant case file samples

18.1.4 Appropriate edits were made for relevant case file samples and‘labels were removed
from edited peaks

18.1.5 Any relevant samples needing re-run were scheduled-and/or disabled
18.2  Determine if sample is suitable for comparison/STRmix™ analysis
18.3 Ifatrue OL/OB was detected in a sample the allele must be‘assigned a call for STRmix™

18.3.1 Open STRmix™ .txt input file and replace OL/OB call with true call.

19 Re-printing/exporting a PDF for aisample from a run that was analyzed in
GeneMarker v 2.8.2

19.1 In the main analysissWindew,
19.1.1  Click'Set Axisé=23€lick Fixed X axis
19.1.2 4The Size Range will be the same as the X- axis range for analysis:
e 60-510 for Fusion
o 90-340 for Yfiler
19.1.3  Select Auto FitY

19.2  Click Tools=> Export Electropherogram

19.3  Set Output Folder to desired location for project PDFs by clicking e icon
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Export Electropherograms @
Output Falder: |M:HSTH_Data\ﬂﬂ_ﬂ&&thenaﬂm B\ Athenald1416_10-11_2016-09-14% J

19.4  Ensure settings match below:

19.5

19.6

19.7

19.4.1 Make sure to select PDF as export format

Select Dyes

v BLUE

v| GREEN

v YELLOW

v RED
ORANGE

Dye Image Size
widthe [1024 80 pisels |

Height: [0 pisiels

[&, Ore imagedper sample
v “Auito Scale Size Fange
[~ AutoSeale Marker Intensity

E xportEomat; ‘ POF file =

[T 2]

19.4.2  For exemplarOrnon=SM analysis: In the suffix field enter the run name with a
before it. (Ex: Newton061316 88-89U A)

19.4.3 “Eor SMhanalysis: In the suffix field enter the run name with a “_ before it followed by
" SMAEx: Newton061316 88-89U A SM) to indicate STRmix™ analysis.

Printing the ladder: Right click in the sample list = click Deselect All > Check the box for the
ladder = In prefix field enter ladders_ = click Export

Printing the controls: Uncheck the box for the ladder and check the box for all controls in the run
- In the prefix field enter controls_ = click Export

Printing the samples: Right click in the sample list = click Select All 2 Uncheck the box for all
ladders and controls in the run, leaving all samples selected = clear the prefix field = click
Export. This will create 4 PDFs for every sample, one for each dye.
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19.8
LIMS.

20 General Overview
20.1 Main Analysis Window

20.1.1

1 Navigator; Sample File Tree
2 Electropherograms

3 Report; Report Table

4 Project Summary

20.1.2 See HELPFUL ICONS INDEX for

er deta

Eile Wew Broject &pplications Tooks Help
=y TERE S

Pg_DNAZ D05 _007.F2

1500 _DkAZL U5 0111
M-150q_DHAzn GOS_013.f
LD 40-Abebic_Ladder 3 HOS

1-19pg_DMazh_eon_002.fs

&3.7.50_DNATa (T D06 f
B #7500 THATS T05_I06
[B <1-7.700_DHazc EDG D10 &
B ). 2500 OhA 6 _012
B 732500 ONAZD 06 014
B 32500 DAz Hos ois!—
? B B-0pg_a A7 00LFm
7 B S-pg b BT Ea
B 510000 C07_005Ba

[ S1-Amp_Pos_a DOT_007 fea o~
4 0] '

Papllp  Paculoun

There are four major displays in the main analysis window

Import all PDFs (initial Fusion analysis and STRmix analysis, as applicable) at the same time into

s-aapE o

[

05-lkledc | adder_1 HO1 O
m

jna-alsic_Ladg
1]1"1-'

=T ]

2
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[54-ang_meiaza_|
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20.2  Navigator; Sample File Tree

20.2.1 This view lists all the samples that are included in the project. Prefixes LD, PC and NC
are labeling the allelic ladder, positive control and negative control

20.2.2  The sheet icon to the left of the sample name indicated the quality of the internal lane
standard (ILS) with the following color/code:

e Green = High Lane Quality; Passing Size Standard =
¢ Yellow = Requires Verification =
e Red strike through = No Sizing Occurrence; faileddo call size Ol

e Red Question Mark = one or more quality, criteria are not met based on the

analysis parameters; See Quality. Reasons'Index for. more details.

20.3  Project Summary

20.3.1 This bar located at the bottom of the,main.analysis screen summarizes the project as
well as alerts the analyst to samples.that did not pass analysis parameters.

MNew 22 samples BC errondll NC error: 313 Ladder error: 0/1 Fhailed=1 #Hagged=19

o New reflects the data set isqot a'project that has been previously analyzed.

o If'the first.ecolumn,reads Modified, the project was previously analyzed in the
software.

e The second column’denotes the number of samples (including controls) contained in
the data set:

e . Columns,3-5 indicate the number of controls in the data set that do not meet the
quality criteria set in the software.

e Column 6 denotes the number of samples that were disabled.

e Column 7 denotes the overall number of samples, except the allelic ladder, that do

not meet the quality criteria set in the software.

20.3.2 Note: Flagging features are an indication of potential failures. The ultimate decision of
passing/failure is made by the analyst after further evaluation.

20.4 Calibration Chart Window
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20.4.1 There are three major displays in the calibration chart window.

1 Sample List
2 Size Standard Template
3 Sample ILS
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20.5

This view lists all the samples that were processed in the project. The Score column
represents how well the size standard template and the sample ILS match. The closer the
score is to 100, the better the match. The sample may fail automatically if the size
standard is bad enough or may have to be failed manually by the analyst.

20.6  Size Standard Template

20.6.1 The template highlights all the peaks that should be labeled in the corresponding sample
ILS for easier comparison.
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20.7 Samples ILS

20.7.1 The sample ILS displays the peaks that were detected. As well as the approximate start

of the data analysis view, indicated by the dash line.
20.8 Browse by All Color Window

20.8.1 There are four features in the Browse by All Color that allow forstraightforward review

of the sample.

1 Sample Drop-Down
2 Max Chart Number
3 Scroll Within a Sample
4 Scroll Between Samples

A U4

B2 Pesiivz corll 082515 0830 81 C03 i

*&Aﬂﬂoior Browser - 02+ Posﬁm: control_{ BﬂZﬁISﬂEBI} BOL 003

ﬂ @\ E’)\ = "\} tﬂa | . é Hax%lt”urﬁ:éﬂ! I.F

e
AR afOh giosizie |[D13s3T | J
D B0 300 0 340 360 380 400 1 450 420 S00

60 &80
b

=)

Destese | [ mastess 4
100 120 140 160 180 200N

3,000

2,000

i1i]

1,000+

T Fi 12
2B 3748|4088
3470 2882 | 1572
12 4 i
3 1738 2132 320.8
[peas _ 3362 2812 2807
[ oiess=m || D135 | DIE1E3E [Ccsriro | | Penta D
250 B0 100 D120 130 160 180 200 220 240 260 260 200 I20 340 360 320 400 420 440 460 430 500
rooods 0
€000
800
3,000} J
2,000 x
1,000 J | | | hl
i A J«L P SR 18
5 15 3 12 12
585 167.8 2638 5421 a247
aren| | 79| avns | 5302 2113 4
13 18 55 ]
1153 175.7 280.7 430.0
5253 3673 3303 1524 - vJ]

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax

software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER



FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR ANALYSIS

GeneMarker Manual
Status:Published Document ID: 6311
DATE EFFECTIVE APPROVED BY PAGE
09/10/2019 Nuclear DNA Technical Leader 32 OF 38

20.9 Sample Drop-Down

20.9.1 The sample drop-down lists all the samples within a project. A user can move between
samples by clicking on the sample name instead of scrolling through all
electropherograms.

T

20.9.2 NOTE: Analysts can zoom in/out by using the zoom icons =N located at the top
toolbar. As an additional option, hold down the left button ofi'the mouse and drag the
dotted box that appears from the upper left to the lower right (around the desired “zoom
in” area). To zoom out, hold down the left button on thé mouse again dragging box from
lower right to upper left. To scroll while zoomed ingfight click andhold while dragging
the mouse in the direction you want to scroll.

20.10 Max Chart Number

20.10.1 Max chart number views each sample by the.number of dye lanes as per the user’s needs
during sample analysis.

20.11 Allele Labels

20.11.1 When analyzing samples in‘the Main Analysis window or the Browse by All Color
window, alleles maybe colored yellow or red.
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20.11.2 This indicates that one or more quality criteria have not been met in the software. See
Quality Reasons Index for more details.

20.11.3 Note: Flagging features are an indication of potential artifacts and/or allelic imbalance,
or peak saturation. The ultimate decision of passing/failure is made by the analyst after
further evaluation.

20.12 Peak Table
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20.12.1 When analyzing samples in the Main Analysis window or the Browse by All Color
window, a peak table maybe added to supplement analysis by clicking Show

Chart/Table icon | =
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20.12.2 This table will indicate to an analyst which alleles were flagged and which quality
reason was triggered. See PEAK TABLE OPTIONS INDEX for further details.
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21 HELPFUL ICONS INDEX

21.1  Main Toolbar Icons

| Icon | Name Function
Run Project | Opens Run Wizard for processing thé data.
| 4
Show/Hide | Allows user to show/hide the frames forthe Sample File Tree,
7 B W Toggles Synthetic Gel Image and Report Tablejrespectively.
Allows usérthe choice of viewing/hiding all color lanes or
B Show Color | single dye lane layer (with single left mouse click on the icon,
v obtain single dyeview)
Allows for more discriminate view of electropherogram.
Zoom/Zoo Alternately, hold down left mouse button and draw a box;
m Out dragging from top left corner to bottom right zooms in on
\ @\ imagewhile dragging from bottom right corner to top left
zooms out.
Default sets Y-axis by maximum peak intensity for the
Set Axis sample displayed. The other 2 options either auto-fit the Y-
% axis by the peak intensity of the alleles displayed, or allow for
setting the X- and Y- axes ranges manually.
Browse Allows for comparative view display of sample
by All electropherograms by dye color. Individual samples can be
g C)(I)lors selected from the drop down menu in the upper right corner
il of the All Color Browser display window.
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21.2  Allele Call Icons available after raw data processing only; Sample File Tree Allele Call folder must be

selected
Icon Name Function
A Size . . . . . .
Calibration Displays calibration charts for linearity of lane analysis.
Show Allows user to toggle the display to'show only the Peak Table,
& Chart/Table the Peak Table and the Electropherogram, or just the
Electropherogram,
. Allows user, to exportithe Peak Table as an Excel(.xls) file or a
Save Peak Table | .\ GutimitedText (.txt) file.
Allows user to call alleles by sample(s), by marker or by dyes.
Allows user to make some modifications to the threshold/filter
N - Call Allele settingg>without having to activate Run Wizard again (i.e. Peak

Detection Threshold, Stutter Peak Filter and Peak Score
Threshold).

Marker

Maer [Nong- v Drop*- Allows user to select a marker to view. Available after the

down samples have been compared to a Panel.

Menu

Event Log Displays the processing success/failure of each dye lane.

a3l Magic Activates the Start Your Project, Run and/or Report dialog
- Wizard boxes.
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21.3  Browse By All Colors Icons
Icon | Name Function
e\ e\ Zoom In/ Same use as in the Main Analysis Screen.
Zoom Out
. Allows user the option to show/hide X- and Y- axis grid
Show/Hide . < .
Mouse Cross lines that appear at the tip of the mouse cursor along with
N Lines the basepair size anddRFU valae of the mouse cursor
position.
?\; Show/Hide Adlows user the option to show/hide the Bin brackets at
- Bin Ranges the top-and bottom of the electropherogram.
. Allows user the option to adjust the RFU intensities of
lﬁs Auto Scale low,peaks to match the 1ntens1ty. of the hlghest'peak gn the
Markers dyecolor. When low peaks are increased, the intensity
magnification factor is noted in the marker (can adjust
from 2X to 8X).
& . Opens the Print Report settings box. Also accessible in the
Print . .
Main Analysis screen.
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21.4 Report Table Icons located directly above the Report Table.

Icon | Name Description
Report Allows user to customize Report Table display
| — | Settings settings.
=] Save Allows user to export the Report Table as an Excel
_— Report (.xIs) file or tab-delimited Text (.txt) file.
Sustomlz Allows,user to select which bins to include/exclude
Bin in the Report Table (check with TSL as this is
Column not accessible at this time)
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22 PEAK TABLE OPTIONS INDEX

Dye dye lane location of peak
Size peak basepair size (x-axis)
Height value given as relative frequency units (RFU) of the peak (y-axis)
Height peak height divided by height of highest peak in the dyelaneor
Ratio Marker
indicates the area under the curve of the peak; calculated based
Area . .
on x-axis Start/End column settings
Area peak area divided by area of highest peak in'the dyeJane or
Ratio Marker
Marker locus location of the peak
bin location of the peak (based on kit/system panel'and ladder
Allele . .
analysis of project)
. absolute value of distance between the peak center and Bin center
Difference | . .
in basepairs
assigns Pass/Check/Undetermined quality ranking for each peak
Quality relative to the AllelesEvaluation Peak Score settings in the Run
Wizard (see AdditionalSettings)
an exponential©urve based evaluation of the peak; calculation of
Score the value is based on signal-te-noise ratio and peak shape (or
morphology)
Start/End | beginning, and\finish basepairs of the peak's Area calculation
Allele so.ftware al.ld user edited comment.s for the peak; right mouse
Comments click peakimchart to add peak edit comments or select from the
drop down list (more in Edit Comments Index)
user added comments for the sample; right mouse click sample
Sample . .
Commenks | Hame in the sample tree to add new sample edit comments or
select from the drop down list (more in Sample Comments Index)
Quality letter code abbreviation(s) of reason(s) for a peak 's Quality
Reasons assignment if ranked Check/Undetermined
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